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Contact CA Technologies

Understanding your Support

Review support maintenance programs and offerings.

Registering for Support

Access the CA Support onlineregistration site to register for productsupport.
Accessing Technical Support

For your convenience, CA Technologies provides easyaccess to "One Stop" support for
all editions of CA ERwin Data Modeler, andincludes the following:

m  Onlineandtelephone contactinformation for technical assistanceand customer
services

m  |nformationabout user communities and forums

m  Product and documentation downloads

m  CA Support policies and guidelines

m  Other helpful resources appropriate for your product

For information aboutother Home Office, Small Business, and Enterprise CA
Technologies products, visit http://ca.com/support.

Provide Feedback

If you have comments or questions about CA Technologies product documentation, you
cansend a message to techpubs@ca.com.

If you would liketo providefeedback about CA Technologies product documentation,
complete our shortcustomer survey, whichis alsoavailable on the CA Support website,
found at http://ca.com/docs.

CA ERwin Data Modeler News and Events

Visitwww.erwin.com to get up-to-date news, announcements, and events. View video
demos andread up on customer success stories and articles by industry experts.
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Chapter 1: Working with CA ERwin Data
Modeler Navidator Edition

This section contains the followingtopics:

Intended Audience (see page 7)

CA ERwin Data Modeler Navigator Edition (see page 8)
Modeling Overview (see page 8)

The Application Development Cycle (see page 9)

Intended Audience

This guide is intended for use by individuals such as business or systemanalysts,
databasedesigners,and programmers who require read-only access to models created
in CA ERwin Data Modeler. You can use CA ERwin Data Modeler Navigator Edition to
view, print,and manipulate models.The only limitationisthatyou cannotsaveany type
of model change, includingany madeto models accessedina martdatabase.

You canusethis product on data models that are on a local drive, network drive, orina
mart databaseto:

m  View the work of others whileitisin progress.

m  Provideinput without inadvertently changing work.

m  Read the informationina model inorder to create queries, reports, or applications.
If you arealreadyfamiliar with CA ERwin Data Modeler, CA ERwin Data Modeler

Navigator Edition offers most of the features currently availablein the full -feature
version of these products.

Note: For more information about product differences, see CA ERwin Data Modeler
Navigator Edition Differences (see page 63).

To usethis product with data models, you should have a working knowledge of
databasemanagement, entity-relationship diagrams,and IDEF1X and IE data modeling
terms. Ifyou areusinga data warehousingenvironment, you should also havea working
knowledge of dimensional modelingterms.

Chapter 1: Working with CA ERwin Data Modeler Navigator Edition 7



CA ERwin Data Modeler Navigator Edition

CA ERwin Data Modeler Navidgator Edition

CA ERwin Data Modeler Navigator Editionis one of the editions of CA ERwin Data
Modeler. These editions providea foundation for building, deploying, and managing
applications. These editions consistof project management, change and configuration
management, modeling and design, and knowledge publication and visualization. They
strengthen your ability to automate critical application lifecycle processes and to thrive
inthe increasingcomplexity and rateof change intoday's business climate. They help
you simplify the complex aspects of analyzing, designing, and implementing applications
by providinga visualization of the relationships between business and technology. The
key editions that providethe integration of design and data models are:

m  CA ERwin Data Modeler Standard Edition--The essential tool for data modeling.

m  CA ERwin Data Modeler Workgroup Edition--Supports concurrentteam modeling
for largeclient/server development projects.

Modeling Overview

Modeling is one of the most effective techniques for understandingand communicating
business rules and processes.Justas anarchitectcreates a blue printbefore buildinga
structure, a databasedesigner creates a data model before buildinga database. A data
model is a graphical representation of a databasethatis usedto capturean
organization's businessrules, which canthen be used to define a system's requirements.

Typically, throughoutthe design process,a model is presented to business users and
other members of the enterprise for review andinput. As a reviewer of a data model,
you may be required to provide inputto the design team.

This productis a read-only version of the CA ERwin Data Modeler database modeling
tool when you are working with data models. You canuse it to create, open,
manipulate, print, and report on any data model. This product maintains mostof the
functionality of the full-featureversion, but you cannot use itto savea data model or to
forward or reverse engineer a database.

You canalsouseCA ERwin Data Modeler Navigator Edition to open models saved ina
shared databasethat was created using CA ERwin Data Modeler Workgroup Edition. If
you want to be ableto access a mart database, contactyour mart administrator. The
administrator mustcreate a mart databaseon a supported DBMS and a security profile
for each user. Your PC must have the appropriate DBMS clientconnection software
before you canaccess models ina mart database,and you must have the appropriate
security permissions. Seethe CA ERwin Data Modeler Workgroup Edition Administration
Guide for more information.
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The Application Development Cycle

The Application Development Cycle

To create a data model, firstthe business rules aregathered and the logical constructs
are created. Next, the physicaldesigniscreated,and then a databaseis implemented.
CA ERwin DM supports this iterative process by supporting multiple platforms, reuse of
objects, and synchronization of changes between data models.

Chapter 1: Working with CA ERwin Data Modeler Navigator Edition 9






Chapter 2: Installation

This section contains the following topics:

Install CAERwin Data Modeler Navigator Edition (see page 11)

Post-Installation (see page 12)
Install the SSL Certificate (see page 13)

Install CA ERwin Data Modeler Navidgator Edition

The Installation Wizard makes iteasy for you to install, change, or remove the software.

To install CA ERwin Model Navigator:

1.

Insertthe installation DVDinthe DVD drive, or double-click the fileyou downloaded
from the online CA product page.

The Installation Wizard opens.
Followthe prompts inthe wizardto proceed.

A License Agreement opens for you to review.

Select the optionto accept the terms as described in the License Agreement. Click
Next.

The wizard asks a series of questions you must answer, including:
m  Customer Information
m Destinationfolder

On the Custom Setup Type screen, review the programfeatures that will be
installed.You canalso evaluatethe spaceneeded to install each feature.

Click Next to continue and then click Install tostartthe installation.

The program files arecopied.

Chapter 2: Installation 11



Post-Installation

Uninstall the Navigator Edition

There is a known issuewith uninstallingthe Navigator Edition.

Symptom:

Suppose that you have installed CAERwin Data Modeler and the Navigator Edition on
the same computer, through separateinstallations. For example, supposethat you have
installed CA ERwin Data Modeler usingthe CA ERwin Data Modeler r9.2.0 installation
wizard and you have installed the Navigator Edition using the CA ERwin Model Navigator
installation wizard. When you uninstall the Navigator Edition, the following messages
appear:

Error 1905 Module C:\Program Files(x86)\CA\ERwin Navigator r9\EAL.dll failed to
unregister. HRESULT-2147220472. Contact your support personnel.

Error 1905 Module C:\Program Files(x86)\CA\ERwin Navigator r9\ERXML.dll failed to
unregister. HRESULT-2147220472. Contact your support personnel.

Solution:

Reregister the ERXML.dIl and EAL.dII files manuallyin CAERwin Data Modeler again.
Note: To avoid this problem,install CAERwin Model Navigator and CA ERwin Data

Modeler from the same installation wizard.Thatis, selectthe CA ERwin Model
Navigator r9.2.0 component inthe CA ERwin Data Modeler r9.2.0 installation wizard.

Post-Installation

Before you canview models ina mart database, you need to connect to the mart
databaseon whichthe models reside. The connection is made by clicking Mart,
Connection on the File menu. The following mustbe performed before you can connect
to a mart database:

m  The clientconnectivity software for your host DBMS must be installed on the client
workstation so that you can connect to the DBMS on which the mart database
resides.

m  The martadministrator mustgive you permissiontoaccess the mart database.
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Installthe SSL Certificate

Install the SSL Certificate

If you have enabled SSL for the Mart, install the SSL certificate. Install the certificateon
the computer from which you planto use the Navigator Edition with CA ERwin Data
Modeler.
Follow these steps:
1. Opena web browser and go to https://servername:18170:MartAdmin.

The server name is the hostname of the server where the Martis SSL enabled.
2. ClickCertificateErrorinthe Address bar and then click View Certificate.

3. ClickInstall Certificatein the Certificate window.

4. Install thecertificateunder the Trusted Root Certification Authorities certificate
store.

You can now connect to an SSL-enabled Mart from the CA ERwin Data Modeler
Navigator Edition.

Chapter 2: Installation 13






Chapter 3: Navidating Data Models

This section contains the following topics:

Data Models (see page 15)

Basic Data Modeling Concepts (see page 15)

WorkplacePanes (see page 24)
Open an Existing Model (see page 41)

Open a Model Saved in XML Format (XML Import) (see page 41)

Connect to Mart (see page 42)

Open a Model or Submodel from the Mart (see page 43)
Customizingthe Appearance of Data Models (see page 45)

Printa Data Model (see page 52)

Data Models

The CA ERwin Data Modeler Navigator Edition contains the tools you need to open,
view, manipulate, print,and report on CA ERwin Data Modeler (CA ERwin DM) data
models.

Although the Toolbox and other features areenabled, you cannot savethe changes you
make to a data model. This productonly maintains thechanges that you make to a data
model until you closethe model. Ifyou need to saveyour changes, you can upgrade to

the full-feature edition.

Basic Data Modeling Concepts

Before creating or working with data models, there aresome basic data modeling
concepts that you must be familiar with. These concepts include:

Model Types

Entities

Tables

Attributes and Columns
Primary Key
Relationships

Foreign Key

Chapter 3: Navigating Data Models 15



Basic Data Modeling Concepts

Model Types
Multiple model types allow data modelers or data analysts to work with the models best
suited for their needs. The following model types are available:
Logical

A conceptual model that contains objects such as entities, attributes, and key

groups.
Physical
A database-specific model that contains objects such as tables, columns,and data
types.
Physical Model Logical Model
WO E W0 | E
mowie_number movie number
mavie_director rating
mowie_description rental rate
mowie_rating qenre
mowie_name movie clip
mowie_geanre description
mowie_rental_rate movie title
MOVIE_COFY W OWIE COPY
[ movie_number movie copy number
| mawie_copy_number mavie number (FK)

general condition

movie_format :
general_condition mavie format

Logical/Physical

A single model that includes both the logical and physical models.
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Basic Data Modeling Concepts

Entities

An entity is alogical objectthat represents a person, place, or thing about whichan
organization maintainsinformation.

Inthe following diagram, the logical data model has the followingentities:

CUSTOMER

EMPLOYEE

MOVIE

MOVIE COPY

MOVIE RENTAL RECORD
PAYMENT

STORE

CUSTOMER E

MOWIECD P"f’%
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Basic Data Modeling Concepts

Tables

Inthe logical model, an entity usually correspondstoatableinthe physical model.In
the physical model, a graphic box represents atable in which datais stored inthe
database.

Customer Table in ERwin |

CUSTOMER

cust_no

name
address

Customer Table in the database |

cust_no | name | address /

1234 [Brown |5 Main S
2345  |Jones [1249
3456 |Smith |77

Types of Entities/Tables

Two types of entities/tables can be drawnin a data model:
Independent Entity

An entity whose instances can be uniquely identified without determining its
relationship toanother entity. Itis represented as a box with squarecorners.

Dependent Entity

An entity whose instances cannotbe uniquelyidentified without determining its
relationship to another entity or entities. Itis represented as a box with rounded
corners.

Independent Entity Dependent Entity

CUSTOMER MOVIE RENTAL RECORD
csbomean num bsr employes 1D

Enlal moodnd number
name micnwie oopy numiber
Sddress Mm@ mumber
p-hclr.-n CUERDMer numbsr
cred it cand
credit caed exp payment anssction number
el oode date

due dabe

#tatus

iaks

cwendue chage
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Basic Data Modeling Concepts

When you add an entity, the entity type is determined based on the relationshipin
whichitisinvolved. For example, when you initially placeanentity ina model, itis
represented as anindependent entity. When you connect the entity to another entity
usingarelationship,itis determined ifthe entity is independent or dependent based on
the relationship type.

Attributes and Columns

After you have discovered the people, places,and events that define the entities inyour
model, you can begin to define the attributes for each entity.

Attributes collectinformationaboutan entity and columns collectinformation abouta
table. Logical attributes usually correspond to physical columnsina table.

For example, after you create the CUSTOMER entity, you can begin to define the
individual pieces of information you want to track for each customer, including Name,
Address, and Phone Number. Inthe logical model, each of these pieces of informationis
saved as an attribute of the CUSTOMER entity. Inthe physical model, attributes equate
to columnsinatable.

zustormer numbery,

name

address An attribute

phl:l e curresp!:mds toa
. column in a table

credit card

credit card exp
status code

e
cust_no ) name | address
P~

Note: A row of dataisinsertedina tablewhen arecord is added to the database
directly or through anapplication.

After you create an entity or table, you canadd attributes and columns, respectively.

Many easy methods for creatingand modifyingthe properties of these objects are
provided. The most basic method is toadd the name directlyinthe Diagram Window.
You canalsouseadomainto add attributes and columns.
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Basic Data Modeling Concepts

Primary Key and Non-Keys

Entities and tables aredrawn as a box with a horizontal linenear the top of the box.

The area above the horizontal lineis known as the key area because thatis where the
entity's primary key resides. The primary key canbe comprised of one or more
attributes that uniquely identify the entity.

The area below the horizontal lineis known as the non-key area becausethat is where
all other attributes reside.

CUSTOMER
customer number

Primary Key

Hare
address
phone
credit card
credit card exp
status code

Non-Keys

Note: A foreign key may appearin either the primary key or the non-key area of an
entity or table. For more information about foreign keys, see Foreign Key (see page 23).
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Basic Data Modeling Concepts

Relationships

An important objectin a data model is the relationship, whichis represented by the
solid or dashed linethat connects two entities or two tables.Arelationshipline
connects a parent and a child entity or table. Usually, a symbol appears atthe child-end
of the relationship line. The symbol changes based on the diagramnotation that you
select.

Child-end of
relationship line

MOWIE RENTAL RECORD

movie rental record phone
customer number (F) j

CUSTOMER
customer number

rental date

due date

rental status

payvment tranzaction number (FI)
owerdue charge

rental rate

credit card

email

credit card exp
customer firt_name
status code
customer last_name
customer address
customer city
customer state
customer Zip_code
customer phone

Parent-end of
relationghip line

Types of Relationships

Relationshipsareimportantbecausethe type of relationship determines how a primary
key of the parent entity or table migrates to the child entity or table as a foreign key.
There are two basictypes of relationships:

Identifying Relationship

An identifyingrelationshipisrepresented by a solid lineand through itthe primary
key of the parent migrates to the primary key area of the child entity or table.

Non-ldentifying Relationship

A non-identifyingrelationshipis represented by a dashed lineand through itthe
primary key of the parent migrates to the non-key area of the child entity or table.
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Basic Data Modeling Concepts

Inan identifyingrelationship, the foreign key migrates above the lineand becomes part
of the primary key of the child entity (see Foreign Key (see page 23) for more
information).Ina non-identifying relationship, the foreign key migrates below the line
and becomes a non-key attribute inthe child entity. A dashed linerepresents a
non-identifying relationship.

CUSTOMER
customer number identifying

cradit card relationship mmigrated
custormer firt_name | key aftribute

credit card exp MOWIE RENTAL RECORD

status code s
customer number <

customer address
custamer phone rental record date
amail

migrated
non-key attribute

due date

rental status

payment transaction number
overdue charge

rental rate

rental date

PAYMENT
payment transaction number

trpe e
jzzunt non-identifying
status relationship

Note: If you want a non-key to migrate instead of the primary key, you can use the
alternate key migration option. For more information, see the online help.

Other Relationship Types

Inaddition to identifyingand non-identifyingrelationships, youcanalso createthese
relationships:

CUSTOMER

Identifyingrelationship

CUSTOMER
FATMEMT

Non-identifying relationship

EMPLOYEE

Recursive relationship
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Basic Data Modeling Concepts

ORMER
. FROCDUCT

Many-to-many relationship

FATMENT

CHECHK
CREDIT

Supertype/Subtype relationship

Foreign Key

When you create a relationship between entities, the primary key attributes of the
parent entity are automatically migrated to the child entity. The designator (FK)

indicates the name of the migrated key attribute, also known as a foreign key. This
migration occurs automatically in the physical model.

MOWIE REMTAL RECORD

mlg{tar:[?[ft:w customer numbar (FI)

CUSTOMER // rental record date

customer numbsr emplyes numbar (FE)
miovie Sopy numbsr (FR)

name miowvie number (F K

W

=ddregs manager FK)

phone

credit cand rental date

credit card exp due date

st=tus code rental ststus
pawment transaction numbsr Fl)
rzntal rate

cwardue chamge
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Workplace Panes

Ifthe foreign key attribute has the same name as an owned attribute inthe child entity,
the two instances areautomatically unified into one attribute becauseit assumes that
they are the same attribute. The process of combiningor unifyingidentical attributes in
anentity is called unification.

Note: The foreign keys displayinthemodel by default, designated by (FK). If you do not
see this designation, open the Diagram Editor (click Diagramsin the Diagram menu), and
do the following depending on whether you are workingin alogical or physical model:

Logical model

Clickthe Entity tab, and ensure the options Display Logical Foreign Key (FK) Designator
and Display Migrated Attributes are selected.

Physical model

Clickthe Table tab, and ensure the option Display Physical Foreign Key (FK) Designatoris
selected.

Workplace Panes

Each of the following panes within the workplaceis dockableand floatable, and where
applicable, containsits own toolbar:

m  Explorer Pane (Model Explorer)
m  Action Log Pane

m  Advisories Pane

m  Overview Pane

m  BulkEditor Pane
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Workplace Panes

Each pane provides two options for how itdisplays:
Il Auto Hide

Activates auto hide. The pane becomes atab inthe application. When auto hideis
activated, the paneis notvisibleinthe workplaceunless you hover your mouse
over the tab of the hidden pane. When you do this, the paneis temporarily restored
to allowyouto work inthe pane. When your mouse leaves the pane, itbecomes
auto-hidden once again. To turn off auto hide, mouse over the tab to restore the
pane, and then clickthe pushpinkz .

= Close

Closes the pane. To open the pane again,selectthe appropriate paneon the View,
Windows menu.

Pane grouping functionalityis provided to assistyou with arranging panesinthe
workplace. Dockable panes candock to other dockable panes sothat they combine to
create multipletabs inasingledockable pane, or pane group. Similarly, tabs on
dockable panes can be undocked / ungrouped and floated or docked to the top level
frame window as individual dockable panes. When two or more panes are docked
together ina tab group, the tab selectioninterfacedisplaysatthe bottom. When panes
are not grouped, the tab selectioninterface is notshown. When tabs are grouped, the
title bar on top of the pane changes to the title bar of the currently activetab.

Model Explorer
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To dock panes together intoa pane group, simplydraganddrop one pane over another.
To undock, dragthe tab of the pane you want to undock and drop it inthe workplace.
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Overview of Model Explorer

The Model Explorer provides an organized, hierarchical, text-based view of your data
model and its contents. It provides an easy method for creating objects. The Model
Explorer lets you create, display, navigate,and modify your model.

The Model Explorer has two panes, Model and Subject Area, as shown in the following
illustration:

Maodel Explorer
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All the objects in your model are listed in the Model Explorer, but display differently
based on the active pane.

m  The Model paneincludes every object in your model includingsubjectareas and
domains.The Model paneis the defaultview.

m  The Subject Areas pane displays model objects that are sorted by subjectarea.

When you change an object inthe Model Explorer, the graphical view of the model is
immediately updated with the same change. For example, if you rename a tableinthe
Model Explorer, the new table name appears inthe DiagramWindowand the relevant
editors.Similarly, if you changean object the diagramorinaneditor, you immediately
see the change inthe Model Explorer.
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Model View

Subject Area View

Just as you cancreate an entity, a table, or arelationship usingthe Toolbox, you can
create an object inthe Model Explorer. To create an object, right-click on any objectand
click New. You can drag some objects from the Model Explorer onto the Diagram
Window to create an object. For example, you candraga domainonto an attribute or a
column.

Usingthe Model Explorer, you can open the property editor for an objectintwo ways:
m  Right-clickthe object and click Properties.

m  Select the object andclickthe Property Editor iconinthe Model Explorer toolbar.
Note: For bulk editing of object properties, you can usethe Bulk Editor.

The Model Explorer and the data model are always insync, regardless of the method
you choose to add or edit an object.

You canalso move, copy, and delete most objects inthe Model Explorer, same as you
doina Diagramwindow.

After you move, copy, or delete anobject, all the instances inthe model that reference
the object are automatically updated.

The primary purpose of the Model view is model explorationandto functionas an
alternativelaunching pointfor object and property editors. The Model view lists all the
object types that appearinthe current data model. The object types thatare displayed
here are based on the model type andthe target server.

For example, if the model type is Logical, the Model Explorer does notinclude physical
objects such as a view. Similarly, if the model type is Physical, the Model Explorer does
not includelogical objects. If the target serveris Oracle, then objects specific to Oracle
suchas Clusters aredisplayed.

The following types of objects are not displayedin the Model Explorer:

m  Minorobjects that areincluded inthe parent object editor. For example, a Valid
Value object is created, deleted, and edited by the Validation RuleEditor.

m  An object that represents configurationinformation, created for aninternal
process,andis not actual model data. For example, as a Complete Compare Option
Set.

The Subject Area view provides a filtered view of the model and minimizes unnecessary
tree information. This view displaysthe model objects that are sorted by Subject Area.
You can create Subject Areas to dividethe model into smaller manageable parts, which
is helpful when you work with large models.
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The followingillustration shows the Subject Area view:
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Select a Subject Area to view the objects thatareincludedinit. For example, inthe
previous illustration you see that the tables are categorized as tables,and views are
categorized as views. This view is different from the display of the Subject Area objects
inthe Model view. Only those relationshipsareincluded herethat arevisibleon the
diagramand have both the endpoints present in the Subject Area.

Note: The global objects that do not relate to the selected Subject Area, such as Subject
Area objects or model sourceobjects are not displayed.

The Model Explorer Shortcut Menu

When you right-clickonan objectinthe Model Explorer,a shortcutmenu displaysthat
lists the options available for that object, similar to the following example:

SR Eritie
EE.-'

m-H E2
=-H EA

To control the topological display of Domains, right-clickon a Domain and select how
you want to sortthe Domains.

i EEEE I |

EE' v Sart Alphabetically
Sort Hierarchicalky

= -

You canalsodelete an object or invoke the property editor for the object. If semantics
do not allowthe deletion of an object (such as a Primary Key object), then the Delete
menu item on the shortcut menu does not appear.

If you want to create a new object, and additional informationis required to complete
the creation of that object(such as a Relationship),a dialogbox appears in which you

must enter the information required.

The Model Explorer Toolbar

The Model Explorer contains a toolbar to help you navigateyour object editing, launch
property editors, delete objects, and invoke online help.

A T
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The ERwin Toolbox

The toolbox is the primary set of tools for drawingand editinga data model. Inthe
Toolbox, use the Select tool to move objects and resizeentity and table boxes. The
cursor changes shapefor each taskso that you know what actionis performed.

=EH RGOS s e MR

You have the optionto resizeany box to meet your presentation requirements. For
example, you may want all of the entity, table, or view boxes to be uniforminsize, or
emphasize one or two boxes by making them larger than the others.

The toolbox changes based on the model type (logical or physical)and thenotation
(IDEF1X, IE, or DM).

For more information aboutthe IDEF1X, |IE, and DM notation, see the onlinehelp.
Alignment Toolbar

The appearanceof your data model is important to you and the others who useit. There
are many features that help you enhance the appearance of your model. You may
already be familiarwith some of the automatic layoutfeatures that helpyou arrange
objects inyour diagram.

A toolbaris provided thatcan help you quickly align the object boxes alongthe top,
bottom, or sides of the boxes.

The tools on the Alignment Toolbar help you quickly arrange model objects.
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Drawing Toolbar

You canenhance a model usingthe Drawing toolbar to create different drawing objects.
The tools work like many other popular point-and-click drawingapplications.Justclicka
tool, clickinthe diagramwindow, and dragthe mouse until the object is the right size.

OooGCOAV O Tixard Y

The Go to Diagram Option

Object Properties

When you have several hundreds of objects ina model, it might be difficulttolocatea
specific object. To locate an object ina diagram quickly, right-click the object in the
Model Explorer and click Go To Diagram. The objectis selected in the Diagramwindow.

Usingthe Model Explorer, you can open the property editor for an object two ways:
m  Right-clickthe object and click Properties.

m  Select the object andclickthe Property Editor iconinthe Model Explorer toolbar.
Note: For bulk editing of object properties, you can usethe Bulk Editor.

Regardless of the method you chooseto add or edit an object or its properties, the
Model Explorer and the data model arealwaysinsync.

Note: Object properties also migratethrough relationship lines. In other words, objects
caninheritproperties from their parent objects.

Object Moving, Copying, and Deleting

Action Log

Just as you can move, copy, and delete attributes and columns in the Diagram Window,
you canalsomove, copy, and delete most objects inthe Model Explorer.

After you move, copy, or delete anobject, all the instances inthe model that reference
that object are automatically updated.

The Action Log works inreal time so you can make modeling decisions duringyour
current session rather than havingto waituntil you savethe model to review changes.
The Action Log lets you determine the best way to work.

Note: Ifthe Action Log pane does not displayintheworkplace,click Action Log Pane on
the View, Windows menu.
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Action Log Panes

Details Pane

As you work on the graphicalview of a model inthe Diagram Window, you can view the
transactioninformationintheAction Log. As you make changes to your model, the
Action Log is updated inreal time. For example, if you create anentity inyour model,
the Action Log reflects this change.

Changes areonly viewablein the Action Log duringyour current modeling session. Each
new session begins with an empty Action Log. When you closethe model, the Action
Log clears. Before closing your model, you can generate a report that lets you view all
the changes made duringthe current session.

The type of objects that appearinthe Action Log is based on the display modeyou are
using.|fyou are working with a logical model, then onlylogical objects appear.|fyou
are workingwith a physical model, then only physical objects appear.

The Action Log lets you search for every transaction and filter by type of change sothat
you caneasilyfind a specific transaction or a set of transactions. This featureis
particularly helpful when working with large models.

The Action Log has two panes, Details and Summary, with correspondingtabs.Select
the Details tabto see every change (transaction) made to a model, or select the
Summary tabto see the net result of changes made to a model.

Note: A transaction is a singleunitof work that is notdivisibleinto smaller components.
The Action Log lets you navigatethrough the transaction tree usingthe Details paneor
the Summary pane.

The Details paneshows all the changes you make to a model duringthe current session.
The Details paneis the defaultview when you launch the program. Changes appearin
the Details panewith the most recent transaction atthe top of the tree, and the first
transaction atthe bottom of the tree. You can either expand or collapseeach
transaction.
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Summary Pane

The toolbar on the Details panelets you reverse a transaction, find a transaction, view
property details,and undo and redo to a selected transaction whileworkingin the
current session.
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Create Table
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Details |y Summary

The Summary pane displaysthenet resultof changes made to the model duringthe
current session. Itprovides a filtered view of all theactions you perform on the model
duringthe current session sothatunnecessarytree informationis minimized, whichis
especially helpful when you are working with large models.

The Session Summary node is the top-level node inthe tree. All changes you make to
the model atthe object level and property level appear below the Session Summary
node inthe tree.
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The Summary pane is similarto the Details paneexcept for the following differences:

m  Whilethe top-level nodes inthe Details paneare transactions, the Summary pane
has only one top-level node with changes appearingbelowit.

m  The Extended Findand Filter feature is onlyavailableinthe Summary pane.

m  The Reverse, Undo to Selected Transaction,and Redo to Selected Transaction
options are not availableinthe Summary pane.

Action Log Shortcut Menu

Action Log Tasks

When you right-clickan objectin the Details panethe Action Log shortcut menu opens.
This shortcutmenu lists the options available based on the actions you performed prior
to opening the shortcut menu. These optionsinclude:

m  Undo to this point(or Redo to this point)
m  Reverse

m  Collapse(or Expand)

m  Expand Transaction

m  CollapseTransaction

Note: A shortcutmenu is notavailable onthe Summary pane.

In addition to viewing the detail and summarytransactions, the Action Log provides a
range of useful features that help you easily perform the followingactions:

m  Llocate text withina transaction, object, or property usingthe Find feature.

m  Usethe Extended Findand Filter feature to locate, filter, and report on the results
of your search. This feature is availableonlyin the Summary pane.

m  View oldand new details relatingto a property transaction usingthe Property
Details feature.

m  Reverse atransaction.This featureis availableonlyinthe Details pane.

m  Undo agroup of sequential transactions. This featureis availableonlyin the Details
pane.

m  Redo agroup of sequential transactions. This featureis availableonlyin the Details
pane.
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Locate Text Using the Find Feature

The Action Log Find dialoglets you search for specific text at the transaction level,
object level, or property level. This optionis availableon both the Details and Summary

panes.
Find E|
Find what: | |
[Irakch case Search
[(Imatch whale word [ Transaction
[Jsearchup Object

By default, the searchincludes the entire tree, starting from the current selection point.
Ifthere is no current selection point, then the top of the tree is used as the starting
point. If the search did not startat the top node, the search wraps to the beginningof
the tree after reachingthe end.
To locate text using the Find feature
1. ClickFindonthe Action Log toolbar.

The Find dialogopens.

2. Enter the text you want to search forinthe Find what text box.

3. (Optional)Select the Transaction, Object, or Property check boxto narrowyour
search.

Note: Since there are no transaction nodes inthe Summary pane, the Transaction
search optionis notapplicabletothat pane.

4. (Optional)Select one of the following check boxes to refine your search:
Match case
Specifies to search on case-sensitive text.
Match whole word
Specifies to search for the entire text string.
Search up
Specifies to search for the text from the bottom up.
5. ClickFind Next.
The next occurrence of text displays.
6. ClickCancel when you are finished searching.

The Find dialogcloses.
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Use Extended Find and Filter

Undo a Transaction

Redo a Transaction

The Extended Find and Filter feature lets you set find and filter criteria and view
property changes.This feature is availableonly onthe Summary pane of the Action Log.
To open the Extended Find and Filter dialog, click the Extended Find/Filter button on
Action Log toolbar.

When the Extended Find and Filter dialogopens, it provides a snapshotof the Summary
pane and lets you filter the information that displayssoyoucaneasilyfind the
information you want.
To use the Extended Find and Filter option
1. ClickExtended Findand Filter on the Action Log toolbarinthe Summary pane.

The Extended Find and Filter dialogopens.
2. ClickFindonthe toolbar.

The Find Criteria dialogopens.

3. Select the Properties, Categories, and Classes thatyou want to find. These options
let you filter the information that displays.

4, ClickFindto startthe search.

The Find Criteria dialogcloses.

5. Clickthe Find Next button on the Extended Find and Filter toolbar to find the next
occurrence of the searchitem.

6. ClickClose.

The Extended Find and Filter dialogcloses.

To undo the lastchangethat you made to your model, use the Undo button on the
Toolbar or click Undo on the Edit menu. This feature undoes one change atatime, and
is reflected inthe Action Log by a dimmed transaction.

To redo a transaction thatyou made to your model, use the Redo button on the Toolbar
or click Redo on the Edit menu. This feature restores one change at atime.

Reverse a Transaction

The Reverse feature inthe Action Log lets you perform an oppositeaction on most
entries that appear duringthe current modeling session. When you reverse a
transaction, the model reflects the changes made to the Action Log. This featureis only
availableon the Details pane, and does not sequentially reverseactions.
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For example, if the Details panedisplays Created [Entity] object:'Entity_5'(id=5) and you
select the transactionand click Reverse, a Delete on Entity_5 isimplied.

Depending on how complex your model is, when usingthe Reverse feature, an attempt
is made to restore the model to its best state. Use the Activity Log to determine
whether your transaction has been properly reversed.

Important! Reverse applies to the entire transaction even if you select only the object or
property level node.

To reverse a transaction
1. Clickthe Details tabinthe Action Log.

2. Select anode inthe tree containinganactionthat you want to reverse, and click
Reverse on the Action Log toolbar.

The opposite action occurs.

Note: You cannotperform a reverse action onthe topmost node inthe tree. Use
the Undo feature instead.You also cannotreverse the transactionin which the
model was created - this transactionis marked with the pinicon.

Undo and Redo to Selected Transaction

The Undo to Selected Transaction featureinthe Action Log lets you undo an entire
range, or a sequential group, of transactions atthe same time. Conversely, the Redo to
Selected Transaction feature lets you restore a sequential group of transactions.

Note: To undo to a selected transaction orredo to a selected transaction, you must be
inthe Details paneinthe Action Log.

As you create transactions on your model, each one moves the previous transaction
down the tree inthe Action Log, with the firsttransactionalwaysappearingatthe
bottom of the tree. When you want to undo a range of consecutivetransactions, the
transactions above, including theone you select areundone. To redo a range of
transactions, thetransactions below, including the one you select are redone.

Important! After performing anundo to selected transaction, you will notbe ableto
redo these transactions onceyou perform a new action, sincethe new action clears the
redo stack.
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Undo/Reverse Comparison

You canundo or reverse changes you make to your model. The followingtable
summarizes the differences between the three availablefeatures,and suggests when it
is appropriateto use each one:

Feature Toolbar When to Use
Undo Standard When you want to undo the last, singleaction you took.
toolbar

This feature is similar to the Microsoft Windows undo feature; itlets you
undo the lastaction taken.

Reverse Action Log When you want to perform an oppositeactionthatis not the lastactionyou
toolbar took inthe current modeling session.

This feature applies to the entire transaction even if you select only the
object or property level node.

You canusethe Undo button to undo areverse action madeinerror. For
some transactions,youcanalsoreversea reverse action.

Note that you cannot perform a sequential reverse usingthis feature.

Undo to Action Log When you want to undo sequential transactions performed inthe current
selected toolbar modeling session.

transaction/ This feature lets you undo a range, or sequential grouping, of transactions at
Undo to this one time.

point

You can perform a redo to selected transaction to the same group of
transactions or a smaller set of the consecutivetransactions inthegroup. You
canuse this feature atany time duringthe current modeling session.

Generate a Session Activity Report

You cangenerate a Session Activity report to view a list of objects created and deleted,
and objects and properties that were changed.
To generate a Session Activity report
1. ClickPinned Reports, Session Activity.rpt on the Tools menu.
The report is generated and opens inthe CA ERwin Report Viewer.
2. (Optional)Exportor printthe report.

3. ClickExiton the Filemenu to close CA ERwin Report Viewer and return to the
diagram.
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Advisories Pane

Overview Pane

The Advisories paneis a dockable, floatable windowin the main workplace. This pane
automatically appears when you start the program.

Advisaries

B®e

Create Entity

Advisories | Ackion Log

The Advisories panedisplays messages associated with actions you perform when
working with your model. Each message on this pane shows you when a change or edit
you make to a property is valid and alerts you when the action you have taken violates a
modeling rule. When alerted, you canimmediately correct your actioninstead of
searchingfor the transaction atsome later time.

In addition to viewing the valid and violation messages, you can obtain details abouta
specificaction thatgenerated the message. For example, ifyou set a property, the
Advisories paneshows a “Set Property” message. Click the Details button on the
Advisories toolbarto display the Advisories Details dialogand get more information
about the property. This feature is particularly useful when you areworking with a large
model and you need clarification aboutthatparticularaction.

The Overview pane provides a smaller, targeted view of the current diagramin the
workplaceand changes dynamically as you make changes to the current diagram. You
canalsousethe Overview pane to change the view of the current diagraminthe
workplaceby adjusting the overview area or zooming in or out.
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Bulk Editor Pane

The Bulk Editoris provided so you canedit a small set of properties over a large number
of objects. Changes and updates are immediately committed as you make them, field by
field.

The Bulk Editor includes a Bulk Editor Wizard for specifying the data to edit and saving
those selections as option sets for use with the model in a future editingsession, or
shared by all models. Becausethe Bulk Editor is empty the firsttime you invokeitina
session, the Bulk Editor Wizardis automatically opened soyou can make your object
and property type selections. Thereafter, the Bulk Editor is displayed as a modeless grid
on a tab page on the CA ERwin Data Modeler main window that shows your selected
objectinstances as rows and your selected properties as columns.You canresize,
rearrange, or floatthe Bulk Editor within the CA ERwin Data Modeler application.
Objects are identified by a fully qualified name inthe Name column, whichis
non-editable. A read-only Type column is next to the Name column that displays the
object type. You can clickthe 2% button on the Bulk Editor toolbar at any time to open
the Bulk Editor Wizard to change the object instances and properties that appearinthe
Bulk Editor.
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Duringa session, openingthe Bulk Editor or the Bulk Editor Wizard displays thesame
settings and data as the lasttime itwas shown. These settings are stored independently
for each model. This is necessarysincedifferent models can have different DBMS
targets and contents, so selections of object types, properties, and object instances can
be different across models. The configuration settings arestoredin the registry,soeach
user retains their own Bulk Editor settings.
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Open an Existing Model

Open an existing model to perform data modeling activities.

To open an existing model

1.

Click Open on the Filemenu.
The Open Filedialogopens.
Select the drive, folder, and model that you want to open and click Open.

The model opens.

Open a Model Saved in XML Format (XML Import)

You canuseXML format to import a model file previously saved in XML format. XML

format replaces the text-based ERX format used in earlier versions of this product. XML
format provides structured markup of model metadata accordingto elements thatare
defined in the XML Schema.

To import a file in XML format

1.

Click Open on the Filemenu.
The Open Filedialogopens.

Select XML Files (*.xml) from the Files of type dropdown, select the directoryand
XML filename that you want to open, and click Open.

The File Open dialogopens.
Select to validatethe XML fileagainstthe schema prior to opening the file.

The fileis verified. You canview the progress of the XML Importinthe progress
dialog.

Note: Any errors that occur during the XML Import process aredisplayedinthe
Advisories Pane.
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Connect to Mart

If you areusing CA ERwin Data Modeler Workgroup Edition, you connect to the Mart to
access models and perform administrativefunctions.

The way CA ERwin Data Modeler connects to the Mart has been redesigned now. Inthe
previous versions, CA ERwin Data Modeler would connect to the Mart (database) server
directly. Now, CA ERwin Data Modeler connects to the Mart through a web server. You
can connect multipleinstances of CA ERwin DM to the Mart from your computer.

At the time of logging on to Mart, you must providethe details aboutthe web server
andthe Mart.

Follow these steps:

Click@

The Connect to Mart dialogopens.

onthe toolbar, or click File, Mart, Connection.

Complete the followingfields:
Server Name
Defines the name of the web server where you have installed the Mart.
Port
Specifies the port number to access the web server.
Default: 18170
Use IIS

Specifies that you want to use the [ISweb server to connect to Mart. This check
box is enabled onlyif you have configured IIS. For more information about
configuringllS, see the Implementation Guide (Workgroup Edition).

Use SSL

Specifies that you want to connect to the Mart through a secured connection.
SSL lets you access the Mart through a secured connection. This check boxis
enabled onlyifyou have configured SSL on your web server. For more
information about configuring SSL, see the Implementation Guide (Workgroup
Edition).

Application Name
Defines the application name of the Mart that you want to connect to.
Default: MartServer

Authentication

Specifies the type of authentication you want to use. You canuse a user name
thatis authenticated either by the MartServer application or by Windows.

User Name
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Defines the name of the user that has access tothe Mart. If you areusinga
Windows-authenticated user name, enter itinthe <domain name>/<user
name> format.

Note: A local Windows user who does not belong to a domain or who is not
part of an Active Directory cannot loginto the Martas a Windows user.

Password
Defines the password of the user.
3. ClickConnect.

If you have selected Use SSL and the security certificateis installed, youare
connected to the Mart.

Note: After you connect to the Mart, if you click Connect to Model Manager again,
a dialogopens seeking your permission to disconnectfrom the Mart.

If your security certificateis notinstalled, the message The certificateauthorityis
invalidorincorrectappears.You must installthesecurity certificateto proceed.

a. ClickOKon the message.
The SSL CertificateInstall dialogappears.
b. ClicklInstall.
The Certificatedialogappears.
c. ClicklInstall Certificate.
The CertificateImport Wizard dialogappears.
d. Click Next.

e. Clickthe Placeall certificates in the following store option button and click
Browse.

f. Inthe Select CertificateStore dialog, select Trusted Root Certification
Authorities and click OK.

g. ClickFinish.

The security certificateis installed and you are connected to the Mart.

Open a Model or Submodel from the Mart

You canselectthe lock option when you open a model. Model locking helps to secure
models and manage how changes are saved to the mart. However, the options available
to you depend upon your security profileand whether another user has already locked
the model. Contact your administrator if you mustchange your security profile.

When you locka model, you also havethe optionto retainthe lock after you end your
session. For example, you can retain the model lock when you work on a model offline
to prevent other users from saving changes to the model.
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When a submodel opens, itloads only the objects related to the submodel. This includes
objects outside but related to the submodel such as foreign key attributes.

To open a model or submodel from the mart

1.

Click Mart, Open on the File menu.

The Open dialogopens.The lockicons inthe Open dialogindicatethe lock status of
a model.

m  Avyellowopen lockindicates a model is open by any user.
m  Aclosedgreen lockindicates a model is locked by you.
m Aclosedred lockindicates a model is locked by another user.

Select a Library from the listof libraries in theleft pane, a Model Name in the right
pane, and one of the followinglocking options for the model or submodel:

Unlocked

You canopen a model in Unlocked mode ifyou have permission to update and
savea model. This option lets several users open and edit the same model.
Users can save their changes to the master model inthe marton a first-come,
first-served basis.As a result, you may have to reconcileany differences with
the changes when you savethe model to the mart.

Locked

If you have permission to update and savea model, you canselect the Locked
option. The model is locked exclusively for your own use and other users can
not savechanges to the master copyin the mart.

Read-only

You canopen a model in Read-only mode if you do not have permission to
update and savea model or if someone has the model opened inlocked mode.
When you selectthis option, you canonlyview the model and saveitlocallyas
a.erwin file (CA ERwin Data Modeler). You cannotsave your model changes
back to the mart.

Click Open.
The model or submodel opens ina separate model window.

Note: Locking a submodel alsolocks the parent model.
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Customizing the Appearance of Data Models

There are many features that you can use to change the way a model displaysonthe
screen and how itappears when you printit. For example, three different notations are
supported: ICAM Definition Method 1 Extended (IDEF1X), Information Engineering (IE),
and DImensional notation (DM). To change the notation, choose Model, Model
Properties, Notation on the toolbar.

You canalsochangethe level of information that displays. For example, inthe logical
model, you can chooseto display entity names only or the entity names, attribute
names, and the key group designators.Similarly, inthe physical model,you candisplay
or hideproperties such as column or datatype.

Display Levels

Two sets of display levels are provided, one for the logical model and one for the
physical model.

These display levels are useful for showing different types of informationina data
model, particularly when different people and groups use the data model for their
specificjobinthe development process.

Logical Display Levels

The Logical Display levels areas follows:
Entity

Displaysthename of each entity ina data model insidean entity box. No other
information displaysfor the entity.

Attribute

Displaystheattributes for each entity ina data model, with the primary key
attributes above the lineand the non-key attributes below the lineinanentity box.
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Primary Key

Displaystheprimary key attributes (those found above the lineinan entity box) for
each entity ina data model. The attributes below the linearehidden, but display
when you switch backto the Attribute Display Level and you canalsoseethem in
the Attribute Editor.

Keys

Displays primary key attributes above the lineand does not display any non-key
attributes below the lineinanentity box. Entity boxes have two attribute boxes;
the upper populated with the PK attributes and the lower populated with the
attributes belonging to all key types except PK.

Definition
Displaysthedefinition for each entity ina data model.
Icon

Displaysthebitmap, if you have assigned oneto the entity. You canassigna
different bitmapto eachentity inthe Icontab of the Entity Editor.

The followingdiagramuses the same entities and illustrates each of the logical
displaylevels:

Entity _ CUSTOMER R RnE
CUSTOMER ORDER
istomerd pedaeid
Attribute AR @ customar-id {FK)
customar-phong ordes-dale
S‘hpp'"'ﬁ'ﬂﬁc-'?.:'i arder-siahss
nstructiong-hast-
) CUSTOMER ORDER
Primary KBy s | cusiomerid "
CUSTOMER ORDER:
Keys s SRR mermre
cusharnersd (FE)
is';ﬂ:ﬂ? e ORDER
iti mdnadusl or corporabon who placas s .
Definition an order o purchass o our Companmy - :Ill'-'gi'-:;' requasied by the customar for
il |
loon ——— | CUSTOMER s =

" ORDER
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Physical Display Levels

The Physical Display levels areas follows:
Table

Displaysthename of each tablein a data model insidea box. No other information
displaysforthe table.

Column

Displaysthecolumns for eachtable ina data model, with the primary key columns
above the lineand the non-key columns below the lineina box.

Primary Key

Displaystheprimary key columns (those found above the linein a table box) for
each tableina data model. The columns below the lineare hidden, but display
when you switch backto the Column Display Level and you canalsosee them in the
Table Column Editor.

Keys

Displays primary key columns above the lineand does not display any non-key
columns below the linein a table box. Table boxes have two column boxes; the
upper populated with the PK columns and the lower populated with the columns
belongingto all key types except PK.

Comment
Displays thecomment for each table in a data model.
Icon

Displaysthebitmap, ifyou have assigned oneto the table. You canassigna
different bitmap to eachentity inthe Icontab of the Table Editor.

Physical Order

Displaystheorder in which each column appears inthe correspondingtable.
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The followingdiagramuses the same tables andillustrates each of the physical display

levels:
Table — cm< & ORDER |
CUSTOMER ORDER
cugtomer-id oedgrad
Column — | Customername & customanid (FK)
custormer~phone order-date
shipping-address ordar-gtatus
- i - insirections-taxt-
CUSTOMER ORDER
Primary Key ———  customaerd " L e—
CUSTOMER
Keys customerid
CUSTOMER ORDER
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Comrment — £ oA cpuersterd by the for
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CUSTOMER ORDER
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Physical Order Cuvonv. e | o order_daie
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Display Options

You arealso provided with display options for entities and their relationships. These
options are useful for showing different types of informationinthe logical model:

m  Entity displayoptions

m  Relationship display options

Use the shortcutmenu to set these options.
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Entity or Table Display Options

You canusethe entity or table display options to view information aboutentities and
tables ina data model.

Zoorm

Display Level k

Table Display Column Datakype
Database YWiew Display 3 Colurnn Domain
Relationship Display k rull Spkion

Prirnary key Designaktor
v Foreign Kew Designator (FE)
v Show Shadows v Alternate Kew Designator (AK)
Default Fontks & Colors, .. Table Owner
Table Cwner using Lser

Stored Display Settings. ..

Harden Physical Mames
UnHarden Physical Mames v Lingenerated Tables

Note: The Format menu changes based on whether the currently displayed model is
physicalorlogical.

Relationship Display Option

In both the logical and physical data model,you can usethe display options to view the
relationship properties.

£00m g
Display Level r
Entity Display »

Felationship Display 4 « Yerb Phrase

Stored Display Sett Cardinality
S A Referential Integrity
v Show Shadows v Subtype Discriminakor

Default Fonks & Calars, ..

Harden Logical Mames
IUnHarden Logical Mames

Font and Color Change for Individual Objects

You canalsochangethe color or font of individual objects in your diagramin the
following ways:

m  Select the object, then clickan optioninthe Font and Color Toolbar

m  Select the object, then right-clickand select Object Font & Color on the shortcut
menu.
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Customize Object Fonts and Colors

When you add an object to a diagram, the default font, color,fill,andlineoptions for
that object type is automatically assigned. Use the Theme Editorto assignthedefault
display theme to objects, or create your own theme. Use the following procedure to
customize the settings for the objects you create.

To customize object fonts and colors

1. ClickThemes on the View menu.

The Theme Editor opens.

2. Navigate the tabs on the dialogto set default color and font information. You can
alsospecify fontand color properties for all model objects, new objects you create,
or current objects in the model.

Note: The tabs that appear vary depending on whether you areworking with a
logical, physical, or logical/physical model.

Click OK.

The new default settings are saved and the dialogcloses.
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Changing the Diagram Window Magnification Level

You canusethe followingZoom options, which are availableonthe CA ERwin Data
Modeler Toolbar and on the View Menu, to view a model atdifferent magnification
levels.

Zoom Out

Decreases the magnification of your model inthe diagramwindow by an offset of
10.

Zoom In

Increases the magnification of your model inthe diagramwindow by an offset of
10.

Zoom Normal

Resets the magnification level to 100 percent.
Fit Model

Reduces the magnification level to fitthe entire model inthe diagramwindow.
Fit Selection

Magnifies a specific area of the model to fit withinthe diagramwindow. Drag the
magnifying glass cursoraround the portion of the diagram window that you want to
view and the appropriateZoom level is applied to the model and fillsthediagram
window with the selected portion.

Notes:

m  Displaymagnificationis managedindependently from printmagnification. When
you printthe diagramwindow, the zoom display settings areignored and allows
you to change the scaletoshow more or less of the diagramwindow on each page.

m  The minimum screen resolution supportedis 1024 x 768. If your screen resolution is
less than the minimum supported, some portions of the screen will notbe visible. If
you are workingin an editor and you cannot see the Close or Cancel buttons, you
can hit the Enter key to closeand the Esc key to cancel.
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Print a Data Model

You can printyour model to your default printer. Before you print, you can customize
options for the printed output.
To print a model
1. ClickPrintonthe Filemenu.
The Printdialogopens.
2. Select from the followingoptions on the Printdialog:
Printer

Specifies the destination printer.Select a printer name from the drop-down
menu. Select Printto fileto save the printoutput to a fileinstead of a printer.

Print range
Printall pages of the model, or a range of pages.
Copies

Prints one or more copies of each selected page. You canalsoselectto collate
the copies.

Print what

Printthe current diagram (the open diagramfrom which you opened the print
dialog), or current selection or all diagrams currently open.

Print order

Specifies the direction taken for the printoutput. For example, if you have a
large model that prints on multiple pages, you canselect "Over, then down" to
create a printout with a horizontal orientation. Or, select "Down, then over" to
create a printout with a vertical orientation.

Fit to page

Specifies to scalethe entire diagramsothatitfits on a single pagefor the
selected printer and paper size. Select the check box to enablethis option.

Note: If you selectthis option and have selected more than one diagramto
print, each diagramprints on a separate page.

3. ClickPreviewto view your output page by page, before startingthe printjob.

Note: The page preview thatis displayed takes into accountthe page margins that
you set in the Page Setup Editor. This means that what you see inthe Preview page
is what will be printed.

ClickZoom Into zoom the diagramto the size of the paper. ClickZoom Out to zoom
the diagramto a sizethat canbe fitinthe Preview window.

To printimmediately, click Print; otherwiseclick Closeto go backto the diagram
window.
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4. Click PageSetup to customize printoptions such as page size, orientation, zoom,
border, color, header, footer, and margin.

Print Only What You Want

You canusethe mouse inthe embedded DiagramWindowinthe Print dialogto perform
the followingtasks:

Change the print scale

Drag a page grid lineuntil your model fits inthe grid pages exactly how you want
the model pages to print.You canalsoenter avaluein the PrintScaling box.

Select specific pages for printing

Hold the CTRL key and click each page you want to print.

Set Printer Options

You canset your printer options before you printthe model.

To set printer options
1. Select PrintSetup from the File menu.
The PrintSetup dialogopens.

2. Accept the default printer, page orientation, paper size, and sourcesettings or
select another option:

m  Select a printer from the printer Name listtoselect a different printer.

m ClickPortraitor Landscapeto selecta different page orientation.

m Select a different paper size from the Size listto change the papersize.

m  Select a different paper source from the Source listto change the paper source.
m Clickthe Properties button to open the Windows Document Properties dialog

to changegraphicand printquality options.

Note: Changingto landscape pageorientation affects both the page grid and the printer
fonts. If you change the orientation for a model, you should adjusttheobjects and
relationshipsinyour model for the new layout.
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Specify an Exact Print Scale Value

You canspecifyanexact printscalevaluein percentage.

To specify an exact print scale value

1.

Select Printfrom the File menu.
The Printdialogopens.

Enter the print scalevaluethatyou want to applyto the objects in the model in the
PrintScaling (%) box, and click the TAB key.

m  Enter a valuegreater than 100 to enlarge the size of model objects.
m  Enter a valueless than 100 to reduce the size of model objects.

The size of the model immediately changes to reflect the printscalevaluethatyou
specify.

Click the Printbutton.

The model prints.

Note: To reset the model to 100% printscale, click the Reset Scalebutton.

Add a Padge Header or Footer

You canadd a customized header or footer (or both) to all the pages when you printa
model. For example, you can printthe Model Name, Subject Area Name, and Diagram
Name at the top of every page, andthe page number, date, and time at the bottom of
every page.

Note: If you manually enter incremental informationin the Header or Footer text box
(for example, page number, date, and so on), you cannot automatically updatethe text.

Atoolbarlﬁ Iﬁﬁ |§1 I Eis provided to make it easy for you to quickly add

the following elements:

Current Page

Page Count
FileName

Subject Area Name
Diagram Name
Time

Date
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Page Mardins

To add a page header or footer

1. ClickPageSetup on the File menu.

The Page Setup Editor opens.

2. Clickthe Margins taband work with the followingoptions inthe Header or Footer
text box:

Clickinthe Header or Footer text box to specifyin which area you want to
insertthe customized text.

Click the appropriate Header/Footer button to automaticallyinsert
information, or use the keyboard to insertother information (for example, your
name).

A preview of your selection displays beneath the text box.

For example, if you selected filename and E/R diagramfor the header, and date
and time for the footer, then the preview would be as follows:

General Margins |

Header jFooter

Header:
Test_Model -- ER._Diagram_4
Fooker:

Si4/2010, 4:39:39 PM

B EEOS

aFiledt -- %Display e

“eDates, YaTime

3. Work with the followingrelated options in the editor:

Indicate page margins (ininches) for the header or footer.

Select the "Keep synchronized with Current Diagram" check box to associate
your selections with the current diagram.

Clickthe Load from Diagrambutton to reset any changed settings to the
settings lastsaved to the diagram.

Clickthe Save to Diagrambutton to savethe current selections with the
diagramfor future use.

4. ClickCloseto saveyour settings, or Cancel to cancel your selections.

By default, the entire pageis used for printing. Before you print,you canset separate
page margins (top, bottom, left, and right) for the current stored display.

When you clickthe Page Setup button inthe Print Model dialog, the Page Setup dialog
opens at the Margins tab.
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Padge Boundaries

Set Print Margins

By adjustingthe page grid boundary lines, you can control how much information prints
on each page. The page grid boundary lines define the individual pages on which the
model objects will print. Using your mouse, you candragthe page gridlines inthe Print
Model dialog (within the thumbnail view) or in the diagram window, so more or fewer
objects are printed on a particular page. To adjustthe page grids fromthe diagram
window, you must firstturn them on by choosingthe Show Page Grid option from the
Format menu. You can turn off the page grids inthe same way.

When you adjustthe page boundary lines, the size of the page grid also determines the
printscale (the size of model objects and fonts). To enlarge the print scale, reducethe
sizeof the grid. To reduce the printscale, enlargethe size of the grid.

Note: The paper sizeyou select determines the dimensions of the page grid. To change
the paper size, click PrintSetup from the Filemenu and then selecta different paper
sizeoption.

You canspecify margins for all pages of your printed model.

To set print margins

1. ClickPageSetup in the Printdialog.
The Page Setup dialogopens.

2. Clickthe Margins tab.

3. Enter a valuebetween 0 and 1.5 inches for the left, right, top, and bottom of the
page.
4, ClickOK.

The Page Setup dialogcloses.

Note: Margin measurements are considered when displayingtheembedded Diagram
Window in the Printdialog.
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This section contains the following topics:

Data Model Reporting (see page 57)

Data Model Reporting

The Query Tool

CA ERwin Data Modeler Navigator Edition supports reporting with ODBC connectivity
usingthe Query Tool. You canalsousethe ODBC connectivityin CA ERwin Data Modeler
to create reports usingany tool that supports an ODBC connection, such as Microsoft
Excel.

The Query Tool provides an easy way to execute SQL SELECT queries againsta model in
CA ERwin Data Modeler, a model ina mart, or againsta databasecatalog.Youcan
execute a query againstthe objects and properties inthe model, the metadata defining
those objects and properties, and the action logthat records the changes that are made
to your model duringthe modeling session.

You cancreate new queries or paste text from another source(suchasa *.sql file)into a
query.

You cansavea query to a .*qry filefor later execution. Query results canbe saved to a
*.csv (comma-separated values)file.

Although the Query Tool provides a built-in query interface in CA ERwin Data Modeler,
you canalsouseanythird-party reporting tool that has ODBC capability to query CA
ERwin Data Modeler modeling data.

Note: For more information aboutusingthe ODBC data sources in CA ERwin Data
Modeler with a third party tool, see the ODBC Reporting Guide.
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Create a Query

Open a Query

You cancreate a query (SELECT statement) by entering text directly in the Query box, or
by pastingtext from another source.
To create a query
1. ClickQueryTool on the Tools menu.
The Query Tool opens.

2. Enter your query inthe Query box, or clickthe paste button on the toolbar to paste
a query from another source.

Your query is ready for execution. Use other features inthe Query Tool to execute

andsave the query.

Note: Before you can execute a query you must be connected to ERwin ODBC orto a
database. For samplequeries and the details of schemas and tables, see the ODBC
Reporting Guide.

You can work with queries you saved to a *.qry fileina previous session,or youcan
optionallyusea *.sql, or MicrosoftSQL Server Query file.
To open a query
1. ClickQueryTool on the Tools menu.
The Query Tool opens.
2. Clickthe Open Query E‘ icon on the toolbar.
The Open dialogopens.
3. Select a *.qry or *.sql fileand click open.

The query text opens the Query box and is ready for execution.

Note: Before you can execute a query you must be connected to ERwin ODBC orto a
database.
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Save a Query

Execute a Query

After you have created a new query or made changes to an existing query in the Query
Tool, you cansaveyour query to a *.qry filefor future use.

To save a query

1. Clickthe Save Query icononthe toolbarinthe Query Tool.
The Save As dialogopens.

2. Select afilename andlocation for your query, then click Save.
Your query is saved and the Save As dialogcloses.

3. ClickClose.

The Query Tool closes.

You can execute a new or saved query againstthe model oragainsta databasecatalog.

Use the following process to execute a query:

m  Open the Query Tool from the Tools menu.

m  Create a new query or open an existing query (*.qry) file.

m  Connect to ERwin ODBC or to a database.

m  (Optional) Select the optionto restrictrow count and enter a number to indicate
the number of rows by whichto restrictresults.

m  Clickthe Execute * icon on the toolbar.

After your query executes, the results displayinthe Results box. Use other features in
the Query Tool to savethe query or saveyour resultset.

Note: For samplequeries and the details of schemas and tables, see the ODBC
Reporting Guide.

Chapter 4: Reporting 59



Data Model Reporting

Execute a Query Adainst a Database

You canrunyour query againsta databasecatalog. Todo this, you connect to the
databasefrom the Query Tool and then execute your query.

Follow this process to runa query againsta database:

m  Open the Query Tool from the Tools menu.

m  Create a new query or open an existing query (*.qry or *.sql)file.

m  Clickthe Connect @ icon on the toolbar.
m  Enter the database-specificconnection criteria inthe Connect dialog.

m  (Optional) Select the Restrictrow count to check box and enter a number to limit
the number of rows returned.

m  Clickthe Execute ! iconon the toolbar.

After your query executes, the results displayinthe Results box. Use other features in
the Query Tool to savethe query or saveyour resultset.

Note: You cannotbe connected to ERwin ODBC and a databaseatthe same time inthe
Query Tool. If you are connected to ERwin ODBC, the (database) Connect iconis
dimmed. Clickthe Disconnect@ icononthe toolbarto disconnectyour ERwin ODBC
connection before you attempt to connect to a database. Also, before you can make a
databaseconnection, the appropriatedatabaseclientsoftware must be installed. See
Database Connection Overview for more information.

Execute a Query Adainst ERwin ODBC

To runa query againstthe current CA ERwin Data Modeler model, you must first
activatethe ODBC connection. The connection may already be active, if you selected the
option to startthe ODBC driver on the Reporting tabin the Options dialog.
To connect to ERwin ODBC
1. ClickQueryTool on the Tools menu.

The Query Tool opens.
2. Opena query (*.qry or *.sql)fileor create a query.

Query text displays inthe Query box and is ready for execution.

3. Clickthe Connect to ERwin ODBC :I'tn icon on the toolbar.

The ODBC connectionis established. The Disconnect@ icon becomes active. Use
other features inthe Query Tool to execute and save the query and resultset.
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Change the Instance of an ODBC Connection

If you have multiple copies of CA ERwin Data Modeler running, the ODBC driver can only
serve data from one instance. By default, this is the firstone started. If you want to
change whichinstance of CA ERwin Data Modeler is handlingthe ODBC connection, you
need to firststop the driver on the one thatis runningandthen start the driver on the
second copy of CA ERwin Data Modeler from the same place.

To change the instance of an ODBC connection

1. Go to the copy of CA ERwin Data Modeler thatis runningfor which you want to
stop the ODBC driver and click Options on the Tools menu.

The Options dialogopens.
2. Go to the Reporting taband clickthe Stop ODBC driver for this instance button.

This button's display changes to Start ODBC driver for this instance once the ODBC
driveris stopped for the currentinstance.

3. ClickOK.
The Options dialogcloses.

4. Go to the other copy of CA ERwin Data Modeler thatis runningfor which you want
to usethe ODBC driver and click Options on the Tools menu.

The Options dialogopens.
5. Go to the Reporting tab and clickthe Start ODBC driver for this instance button.

This button's display changes to Stop ODBC driver for this instance once the ODBC
driveris started for the currentinstance.

6. ClickOK.

The Options dialogclosesand youare ready to startconstructinga query.
Restrict Row Count in Query Results

When executing a query againsta large model or database, you may want to restrictthe
row count for the query. This causes the Query Tool to process onlythe first n number
of rows indicatedin the number field. This may be helpful if you have executed a query
that returns lengthy results, but the section of the results that you would liketo seeis
containedinthe first100 rows, for example. In this case, enter 100 inthe Restrict row
count to number field, and the query will only return the first 100 rows.

To restrict row count in query results

1. ClickQueryTool on the Tools menu.

The Query Tool opens.

2. Select the Restrictrow count to check box, and enter a number in the adjoining box.

|:| Reskrick row count ba:

Chapter 4: Reporting 61



Data Model Reporting

When your query runs, the results that display arerestricted to the first n number
of rows you indicate.

Save a Result Set toa CSV File

After you have executed a query and the results displayintheResults box, you cansave
the results to a *.csv (comma-separated values) fileto work with itin other reporting
tools, or to sharewith your modeling team.

To save aresult set to a *.csv file

1. ClickQuery Tool on the Tools menu.

The Query Tool opens.

2. Opena query fileor create a new query and click the Execute +J iconon the
toolbar.

Your query results displayintheResults box.

3. Clickthe Save Result Set as CSV L1 icon displayed next to the Restrict row count to
box.

The Save As dialogopens.
4. Enter a filename and location for your fileand click Save.

The fileis saved, the Save As dialogcloses,and youarereturned to the Query Tool.

62 User Guide



Appendix A: Product Differences

This section contains the following topics:

CA ERwin Data Modeler Navigator Edition Differences (see page 63)
Data Model Disabled Menu Items and Toolbarlcons (see page 64)

CA ERwin Data Modeler Navidgator Edition Differences

You canusethis product to view, manipulate, print, and report on models on a local
drive, network, or on a mart database.

The toolbar, menu and dialogoptions thatare unusableinthe components of this
product are either absent or grayed out to showthat they are disabled. For experienced
users who are already familiar with CA ERwin Data Modeler, the options that arenot
availableinthis productarespecifiedin the followingsections.
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Data Model Disabled Menu Items and Toolbar Icons

The following menu items and their correspondingtoolbaricons areunavailable when
you are working with data models using CA ERwin Data Modeler Navigator Edition:

File
Save
Save As
Mart, Save
Mart, Save As
Mart, Lock
Mart, Version Manager
Mart, Library Manager
Mart, Session Manager
Mart, Security Manager
Mart, Submodel Manager
Export to External Format
Actions
Database Connection
Reverse Engineer
Forward Engineer (all rollover menuitems)
Design Layers (all rollver menu items)
Tools
Standards (all rollover menuitems)
Add-Ins (all rollover menu items)
Options
Report Designer

Export to PDF
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